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لوحة الدليل إلى مرحبا بك في 

.AFF IoTة الإلكترونيةلوحاليحتوي هذا الكتيب على المعلومات اللازمة لاستكشاف 

.ك الخاصةتعرف كيفية البدء في إنشاء مشاريعك وتجاربوف عند الانتهاء من هذا الكتيب ، س

!هيا نبدأ
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مفاهيم أساسية

4

بين الدماغ البشري و المتحكم المصغرشابهوجه الت

الإهتزاز

الحرارةالعائق

الرطوبة

النظرالضوء

الشم السمع

التذوقاللمس

بعضوتنفيذلأداءمكرس،واحدةدارةفيمدمجكمبيوترجهازهوالمصغرالمتحكم

راجإخأولاستقبالللبرمجةقابلةجانبيةأجهزةوعلىذاكرة،علىيحتويفهو.المهام

أجهزةتخدامباسالبيئةمنالبياناتيجمعفهو.الإلكترونيالدماغإلىبالإضافةالمعلومات

يقومثمج،المبرملاحتياجاتوفقاجمعهاتمالتيالبياناتيعالج.(الحساسات)الاستشعار

(.إلخالضوء،تشغيلالمحرك،فيالتحكم)ذلكعلىبناءالإجراءاتبتنفيذ

باستخدامالبيئةمنالبياناتيجمع.العصبيللجهازكمركزيعملعضوهوالمخ

إلىجنباًاليةالحللاحتياجاتوفقاًجمعهاتمالتيالبياناتيعالجالحواس؛أعضاء

أوامرلأداءيرسلثم،المماثلةالسابقةالظروفمعجنب

(ذلكإلىوماوالتحدثالمشي)لذلكوفقاًإجراءات



؟حة لوماهي 
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حكمالتيتمبالإنترنت،متصلةأشياءمن(IoT)الأشياءنترنتإيتكون•

مجدمنيتكونتقنيا،.مكانأيوفيوقتأيفيومراقبتهافيها

أوثابتةالالشبكاتعبربالإنترنتمتصلةوأجهزةالاستشعارلأجهزة

.اللاسلكية

.الذكيلمنزلا:الأكبرالمفهوممنجزءالأشياءإنترنتأجهزةتعد•

.نالأمأنظمةوالوسائطالهواء،تكييفالتدفئة،الإضاءة،ويشمل

اءالأضوتشغيلإيقافضمانطريقعنالطاقةتوفيرويعتبر

المدىطويلةالفوائدبينمن,استخدامهاعدمعندتلقائياًوالإلكترونيات

.الأشياءأنترنيتلتوظيف

AFFحةلوتعد• IoTلوحةمعمتوافقةدقيقمتحكمعنعبارة

.مدمجةWi-Fiوحدةتتضمنوالأردوينو



لوحة
المكونات

(الموصل الأسطواني)دخل الطاقة1

فولت9جهدذاتالبطاريةأوالكهربائيمحولالمعويعملللوحة،الطاقةيوفر

فولت15إلىفولت7منالمقبولالمدخلجهدنطاقتراوحي.فولت12أو

نفذم2

.USBيوفر الطاقة ويربط اللوحة بالكمبيوتر عبر 

(: الإرسال/: الاستلام)الصمام الثنائي المضيء 3-4

\انات من المتحكم المصغر البيرسلي\تضيء هذه المصابيح عندما يستقبل

.إلى الكمبيوتر

(مدمجثنائي مضيئصمام)13الصمام الثنائي المضيء 5

.ح أم لايرتبط هذا الصمام بالبرنامج لإظهار ما إذا كان البرنامج يعمل بشكل صحي

.13الرقمي بالمأخذعبر مقاومة ول وصهو مو 
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لوحة
المكونات

(الإرسال, الإستقبال, الرقمي, الأرضي)مآخذ 6

.تسلسليةمآخذ مختلفة للمدخلات والمخرجات الرقمية، والاتصالات الكتستخدم 

(الأحمر و الأزرق)الصمام الثنائي المضيء7

لوحة الأزرق إلى حالة اليشيربينما .يعتبر الصمام الأحمر مؤشرا للطاقة

(أم لالتعملمهيئة)

"المصنع"زر إعادة ضبط 8

اي يحذف بيانات الواي فحيث ، إلى إعدادات المصنعيعيد ضبط اللوحة

(ثوان لإعادة الضبط5اضغط لمدة . )من اللوحةوبيانات الحساب

التشغيلالواي فاي وزر إعادة تشغيلزر إعادة 9-10

ويعيد الاتصال الخاصة باللوحةالواي فاييقوم الأول بإعادة تشغيل وحدة 

(  شغيل الكودإعادة ت)، والثاني يعيد تشغيل المتحكم المصغر (الإنترنت)خادم بال

(.نقرة واحدة)
7

6

9

8

7

10



لوحة
المكونات

(الطاقة, المدخل التماثلي)مآخذ 11

و ( تفول5وتفول3,3)للمخرج , تستعمل مآخذ مختلفة للمدخلات التماثلية

.الأرضيالمأخذ

وحدة الواي فاي 12

من اللوحةلتمكينه مدمج فيTCP/IPبروتوكول متحكم دقيق مع عبارة عن

.نترنتالإتصال بالإ

مآخذ مدخلات دائرة البرمجة التسلسلية13

.تستعمل لبرمجة اللوحة عبر مجموعة أدوات البرمجة

المتحكم المصغر 14

AFFوهو المتحكم المصغر للوحة  IoT ,أونو وهي مماثلة للوحة الأردوينو

.التقليدية

8

13

11

14

12



برنامج الأردوينوتحميل 

9

نترنتالاتصال بالإ

الموقعمن(مجانا)الأردوينولبرنامجإصدارآخربتحميلقم

www.arduino.cc

للمتصفحالعناوينشريطفيالتاليرابطالأكتب

https://www.arduino.cc/en/Main/Software

تحميل

الماك أو , زالوينداو)قم باختيارحزمة تثبيت نظام التشغيل المناسبة 

(.لينوكس

1

2



الأردوينوبرنامج حول

ى صفحة قم بفتح برنامج الأردوينو في حاسوبك وستر

.مماثلة لهذه التي على الجانب

10
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9
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والأردوينبرنامج حول
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تحقق

،البرمجيةالكوداتمنوالتحققالترجمة

أوالأقواسكنسيانالأخطاءلاستكشاف

.المنقوطةالفاصلة

رفع

.AFFلوحةالىالبرمجيةالكوداتإرسال

الصمامانيومضعليهالضغطعند

.عةبسر(الاستقبالوالأرسال)الأصفران

جديد

تضميوالتجديدةبرمجيةتعليماتنافذةفتح
و،()loopو()setup:الوظيفتين

.بعدفيماشرحهماإلىسنتطرق

فتح

ليةالتسلسالمعلوماتكلتظهرنافذةفتح

AFFلوحةترسلهاالتي IoT.مهمةوهي

.البرمجةكوداتلتصحيحجدا

حفظ

.الحاليةالمسودةحفظ

ةالشاشة التسلسلي

.قديمةمسودةفتح

سم المسودةإ

.المسودةاسمعرض

البرمجةنطقةم

تالكودالتركيبالمخصصةالمنطقةوهي

.المسودةفيالبرمجية

مساحة الرسائل

فيأخطاءبوجودالمبرمجبإعلامتقوم

ةعمليبنجاحتخبرهكما,البرمجةكودات

.الرفعأوالتحقق
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ة للمتغيرات تستعمل هذه الوظيفة لإعداد جميع ترتيبات المآخذ والواجهات وكذا القيم البدائي

.المستعملة

.التشغيلتعمل هذه الوظيفة عند تشغيل اللوحة و عند الضغط على زر إعادة 

()setupة وظيف

ات البرمجية المكتوبة داخل هذه الوظيفة مرارا وتكرارا طالما أنكودتعمل كل ال

.اللوحة مزودة بالطاقة

.تستعمل هذه الوظيفة لتنفيذ الكودات البرمجية بدون توقف

()loopوظيفة 

للأردوينوالوظائف الأساسية 

من أجل التعليق في السطر الواحدههذ //

من الجيد وضع وصف في البداية  //

وقبل أي شيء صعب //

هذا للتعليق متعدد الأسطر/*

...مثل هذا

*/...و هذا



ودالكو تعلم أساسيات البرمجة

مجةالبرمفاهيمجميعالتاليالقسمفينشرح

AFFبلوحةللعملاللازمة IoTإلىبالإضافة

.التوضيحيةالأمثلةبعض

13
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المتغيرات الصحيحة

تحملأوعيةعنعبارةالمتغيرات•

.مؤقتاالقيمأوالأعداد

ينةمعقيمةيحملأنيمكنمتغيركل•

.“=“الرمزباستعمال

يمكنالحسابيةالعملياتكل•

ئجهانتاتوضعأنيمكنو,استعمالها

.آخرمتغيرفي

المتغيرات السلسلة

معدالمتغيراتمنالنوعهذا•

تكونرموزوحروفتخزينل

.جملةأوكلمة

نيمك,الصحيحةالمتغيراتومثل•

كوينلتمعاالسلسلةالمتغيراتدمج

الرمزباستعمالأخرىسلسلة

“+”.

المتغيرات المعرفة

.الثابتةللمتغيراتمماثلةهي•

المآخذأرقاملربطعادةتستعمل•

.الفيزيائيةبالمكونات

يمكن,بنوعهاللتعريفحاجةلا•

.مباشرةربطها

الرمزاستعمالدونتعرفوهي•

“=“.

المتغيرات الثابتة

مةقييحملالمتغيراتمنالنوعهذا•

كانمأيفيتغييرهايمكنلاثابتة

.البرمجيةالكوداتمن

مالإسبإضافةبهاالتعريفيمكن•

“const”نوعهاقبل.

الثابتةاتالمتغيرقيمةتغييريتسبب•

.التحققفيبخطأ

الطويلةالمتغيرات العشرية و

عمالباستالعشريةالمتغيراتتعرف•

.”float“النوع

يراتللمتغمماثلةالطويلةالمتغيرات•

.يرةكبقيماتحملأنهاغيرالصحيحة

المتغيراتتعريفمجاليتراوح•

-2147483647بينماالطويلة

2147483646+و



مفاهيم عامة
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وظائف و مكتبات

الوظائف
المكتبات

.مهمةنفذتالتيالتعليماتمنمجموعةعنعبارةالوظيفة-

العملياتبعضتنجزو(المثالفيكماbوa)عواملالبعضتأخذوهي-

.(cفيbوaجمعوهي)النتيجةتخرجثم(المثالفيالجمع)

بوتعرف)قيمةأيتخرجوألاعواملأيتأخذألاالممكنمنأنهاكما-

void function)الوظيفةمثلprint.

مثل)إضافيةوظائفكوداتكلتوفر++CأوCبلغةمكتوبةملفاتعنعبارةهيالمكتبات

لوظائفاالعباراتهذهتجعل.(إلخ،حساسقراءةأوالسيرفو،محركفيالتحكمعلىالقدرة

.المسودةفيللإستخداممتاحةالمكتبةتحددهاالتيالثابتةمتغيراتوال

،"Sketch“قائمةإلىالانتقالسوىعليكما،المسودةفيموجودةمكتبةلاستخدام-

Import“واختر Library"،ةعبارإدراجإلىذلكسيؤدي.المتاحةالمكتباتمنواختر

include#ملفلكلسودةالممنالعلويالجزءفيh.)المكتبةمجلدفي).



تعليمات التحكم
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البيان الأكثر أهمية
.صحيحامن الشرط وتنفذ العبارة التي تليه إذا كان الشرط ifتتحقق عبارة 

.الوحيدهو البيان الشرطي( المعرّف بواسطة الفاصلة المنقوطة)فيصبح السطر التالي ifيمكن حذف الأقواس بعد عبارة 

.البيانات التي يتم تقييمها داخل الأقواس تتطلب استخدام عامل واحد أو أكثر كما هو موضح أدناه

:عوامل المقارنة

x)  x==y  تساوي(y

x)  x ! =y  تساوي(y

x)  x <y  أقل من(y

x)  x > y  أكبر من(y

x)  x <= y  أقل من أو تساوي(y

x)  x > = y  أكبر من أو تساوي(y

علامة المساواة الفردية if(x = 10)على سبيل المثال )احذر من استخدام علامة المساواة الفردية عن طريق الخطأ 

.(xفي المتغير10تضع القيمة )10داخل xهي عامل تعيين  

هو عامل المقارنة ، ويختبر ما و if(x == 10 ))على سبيل المثال )بدلاً من ذلك ، استخدم علامة المساواة المزدوجة 

.  أم لا10تساوي xإذا كانت 

.ولكن العبارة السابقة ستكون صحيحة دائمًا10تساوي  xالعبارة الأخيرة صحيحة فقط إذا كانت
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AFF IoTالتسجيل في تطبيق 

AFF)تطبيقتحميلبعد IoT),جديدحساببإنشاءقم.

إلايستغرقولاخطواتعشرةالحسابإنشاءحتاجي

.دقيقتين

حمتصفاستعماليمكنك,ذكياهاتفاتملكلاكنتإذا

...إلخ,فايرفوكسأوكروممثلالكمبيوترفيالأنترنيت

,  أو عند الدخول إليه, إذا واجهتك مشكلة عند إنشاء حساب جديد *

support@affcity.comفيمكنك مراسلتنا على 
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تطبيق 

".REGISTER"أنشئ حسابا بالضغط على تسجيل 1.

.المعلومات المطلوبةئقم بمل2.

كلمة بعدها قم بالدخول باستعمال البريد الإلكتروني و3.

.السر
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تطبيق 

ق إضغط على الزر الأزر, إذا كنت تملك حسابا مسبقا1.

"LOGIN"

كلمة بعدها قم بالدخول باستعمال البريد الإلكتروني و2.

.مرورال
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تطبيق 

الشرح في الفقرة )AFF IoTقم بتسجيل لوحة , بعدها

 !تكون مستعدا لإنشاء مشاريعكسبعدها.(التالية



بالكمبيوترلوحةتوصيلقم ب

.بالكمبيوترUSBمن منافذ منفذبأي AFF IoTلوحةتوصيللmicro USBستعمل كابل إ

.ثم قم بفتح صفحة الوايفاي بهاتفك الذكي أو الكمبيوتر

21
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ئحة إذا لم تكن شبكتك في هذه اللا

ضغط على هذا الزراف

 AFF IoTأختر لوحة 
ي  خاصتك من قائمة الوايفا
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اضغط على هذا الزر للوصول  إلى موقع 

affcity.com أو على زر الإلغاء للعودة

AFF Remoteإلى تطبيق 



24

وأخيرا

AFFتطبيقفتحإ IoT,لكتظهرأنيجب

AFFلوحة IoTنترنتلإبامتصلة.

NEWتلقائيااللوحةتسمى MODULEو

.الاسمهذاتغييريمكن
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بيوترالكمخدميمستبالنسبة ل

بدلنهأإلا,سابقاالمشروحةالطريقةنفستتبع

AFFالتطبيقاستعمال IoTالموقعإلىتنتقل

https://affcity.com/iot/modules

.التطبيقباستعمالمبينهوكماتكملو

.

https://affcity.com/iot/modules
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مشروعا12إنجاز 



:مجموعة تضم 

أسلاك التوصيل

ألوان مختلفة

صمامات مضيئة 

5x5, حمراءx5, خضراءxزرقاء ,

5x5, صفراءx بيضاء و اثنتانRGB

زرارأ

أزرار مربعة الشكل

مقاومة متغيرة 

0Ωو5kΩمقاومة متغيرة تتراوح بين 

2727



:مجموعة تضم 

x6 10مقاوماتKΩ

0.5W 5%

x4 1مقاوماتKΩ

0.5W 5%

Ωمقاومات 

0.25W 5%

ة خلايا ضوئي

((LDRمقاومة معتمدة على الضوء 

2828



:مجموعة تضم 

الرطوبةحساس الحرارة و

مقاومة حرارية

1KΩ 25على درجة حرارة°C

جرس

جرس ذو قطبين

لوح التجارب

مأخذ400لوح التجارب ذو 

2929
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:الموجب

يالرأسالعمودفيمكانأيتزويدعلى+علامةكلتعمل

.الطاقةب

:الأرضي

.-علامةطولعلىالرأسيالعمودفيمكانأيفييمتد

a-e):الأفقيةالصفوف & f-j)
خمسةمن30-1منالمرقمةالصفوفهذهمنكليتكون

سنففيالمآخذعلىالموصولةالمكوناتكل.أفقيةمآخذ

.البعضببعضهاموصولةتصبحالصف

لوح التجارب
.ياتهو قاعدة البناء للنماذج الأولية للإلكترونالتجاربلوح



المدمجالثنائي المضيئوميض الصمام1

 32الصفحة

راربالأزالثنائي المضيئالصمامالتحكم في 2

42الصفحة

تغيرةالمقاومة المباستخدام المضيئالصمامخفت3

51الصفحة 

ستعمال الشاشة التسلسليةإ4

61الصفحة 
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"(نترنتالإ"عبر )الثنائي المضيئالتحكم في الصمام5

67الصفحة 

"(الإنترنت"عبر )قراءة شدة الضوء6

78الصفحة 

"(الإنترنت"عبر )مراقبة درجة الحرارة 7

86ة الصفح

"(الإنترنت"عبر )قياس الحرارة والرطوبة8

94الصفحة 

"(الإنترنت"عبر )الصمام المضيئلونضبط9

107الصفحة 

التحكمجدولة 10

117حةالصف

محاكاة نظام الإضاءة الآلي11

128الصفحة

رتفاع درجة الحرارةإإنذاربناء دارة 12

141الصفحة
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دمجالمالثنائي المضيئوميض الصمام

:لجملةايظهربرنامجهلجعلكافيةبرمجيةكوداتكتابةهومبرمجأييتعلمهماأول

"Hello World!")الشاشةعلى(!عالمبالمرحبا.

.الكمبيوترعالمفي"!عالمبالمرحبا"مرادفهوالمدمجالصماموميض

AFFلوحةإلىإلاتحتاجلنالمثالاهذفي IoTكابلوUSBmicro.

وينطفئثانيةلمدةيضئ13المضيئالثنائيالصمامجعلهوالمثالهذامنالهدف

.متكرربشكلواحدةثانيةلمدة
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بالكمبيوترقم بربط لوحة 

.بالكمبيوترUSBمن منافذ منفذبأي AFF IoTلوحةتوصيللmicro USBستعمل كابل إ
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:اختر اللوحة 

:ملاحظة 

في لائحة برنامج AFF IoTد لوحةجتنل

بدلا عنهايمكنك اختيار, الأردوينو

“Arduino/Genuino UNO”  .
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اللائحةىعلالضغطعبرللوحةالتسلسليمنفذالخترإ

Tools → Port.

إعادةواللوحةفصليمكنك,بالضبطالمأخذلمعرفة

.ةاللوححتماهويختفيالذيالمأخذ,اللائحةفتح

.المأخذهذاواختراللوحةتوصيلبإعادةقم

.المطروحالمثالعنيختلفقدذنفالمرقمنأ

يقم باختيار جهازك التسلسل

(الويندوز)

:الرابطهذابزيارةقم,اللوحةإيجادتستطعلمإذا:ملاحظة

https://learn.sparkfun.com/tutorials/how-to-install-ftdi-drivers/windows---in-depth !

https://learn.sparkfun.com/tutorials/how-to-install-ftdi-drivers/windows---in-depth
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لي قم باختيار جهازك التسلس

(الماك)

لائحة اختر الجهاز التسلسلي للوحة عبر الضغط على ال

Tools → Serial Port  ثم قم باختيار

/dev/tty.usbmodemأو

/dev/tty.usbserial
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فتح المثال إ

حقم بفت, بالكمبيوترAFF IoTلوحة توصيلبعد 

ج الموجود في لائحة الأمثلة في برنامBlinkالمثال 

.الأردوينو
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المثال 

يعد هذا المثال بمثابة الأبجدية لعالم

!المتحكم المصغر



تعليمات برمجية يجب تدوينها

39

digitalWrite(LED_BUILTIN, HIGH):

(.فولط0)LOWأو ( فولط5)HIGHالمخرج الرقمي يمكن تعريفه إما ب 

pinMode(LED_BUILTIN, OUTPUT):

.OUTPUTأو مخرج INPUTيجب تعريفه كمدخل , قبل استعمال أي مأخذ من اللوحة

.كمخرج( 13المرتبط بالصمام )13لتعريف المأخذ ()pinModeنستعمل الوظيفة 

delay(1000):

(من أجزاء الثانية1000تضم الثانية .)محددة كعامل(بأجزاء الثانية)تقوم بتوقيف البرنامج لمدة معينة 
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…وأخيرا

1

بدالهباستالنظامويقوم,البرنامجمعالجةتتم

.المصغرالمتحكميفهمهابتعليمات

المتحكمإلىUSBعبرالتعليماتإرساليتم

بتطبيقتبدأالتي,اللوحةداخلالمصغر

.أوتوماتيكياالبرنامج

1



ستلاحظ ؟ماذا 

41

.وتكرارامرارالثانيةوينطفيءواحدةلثانيةيضيءالصمامأنستلاحظ

علىةنظرألقأو,المعالجةلأخطاءوجودلاوأن,اللوحةالىصحيحبشكلحملتقدالتعليماتأنتأكد,ذلكيتملمإذا

.أسفلهالمساعدةتعليمات

يحمل؟لاالبرنامج

هوالسببيكونماوغالبا,أحياناهذايحدث

فيذلكتغييريمكن,الخاطئالمأخذاختيار
tools -> serial port

مساعدة

يضيءلا13الصمام

ربالكمبيوتاللوحةاتصالمنتأكد

.صحيحبشكل

يحمل؟لامازال

هوةالإلكترونيالأجهزةلكلالمشتركالحل

.جديدمنتشغيلهاإعادةثمإطفاؤها



صمام مضيء Ω مقاومة أزرار

42

التحكم في الصمام بالأزرار 2

Ω مقاومة أسلاك التوصيل
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الأزرار

ملتع,البسيطةالمداخلأهمبينمنالأزرارتعتبر

الزريكونعندما,يليكمااللوحةمعالأزرار

رففتتصهذااللوحةتقرأ.الطاقةتنخفضمضغوطا

.لذلكتبعا

للحفاظpull-upمقاومةنستعمل,الدائرةهذهفي

لزرايكونلاعندماالأعلىالمستوىفيالطاقةعلى

.مضغوطا



انتبه
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صمام مضيء

ل الساق القصيرة ، مع الجانب المسطح ، يتص

.(-)بالقطب السلبي

Ωمقاومة

:  يجب أن يقرأ النطاق اللوني كما يلي 

.الذهبي-البني-البرتقالي-البرتقالي

.يمكن لكلا الساقين أن يتصل بأي مأخذ
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المنطق؟كيف نستعمل 

إذاحةأوالمرو،بارداالجوأصبحإذاالتدفئةتشغيليمكنك

.إلخ،التربةجفتإذاالنباتاتوسقيحارا،الجوكان

منمجموعةهناك،القراراتهذهمثلاتخاذأجلمن

رطيةشعباراتلبناءدمجهايمكنالتيالمنطقيةالعمليات

.معقدة

:مثال 

if ((mode == heat) && ((temperature < threshold) || (time == “night”)))

digitalWrite(HEATER, HIGH);
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افتح المسودة

AFF IoT Board folder > Circuits > Using_PushButtons
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Button1State = digitalRead(Button1Pin):وظيفةنستخدم،رقميةمدخلاتلقراءة

فيالطاقةكانتإذاأو،فولط5هيالمأخذفيالطاقةكانتإذا”“قيمةستخرجوهي.

.فولط0هيالمأخذ

pinMode(Button1Pin, INPUT):قبل.للمخرجاتوكذلكللمدخلاتالرقميةالمآخذاستخداميمكن

المستخدمالمأخذتحديديجب،البدء

if (Button1State == LOW):الضغطعندقراءةفسيتمبـالزربتوصيلقمنالأننانظرًا

.الزرعلىالضغطتمإذامالمعرفة)"=="("التكافؤ"عاملاستخداميتم.عليه

Else:بعددةالموجوالبرمجيةالكوداتتنفيذفسيتم،صحيحغيرعبارةفيالشرطكانإذاأنهتعني

Elseالأقواسبين.

..تعليمات برمجية يجب تدوينها



اإذ(الكودانظر).معاالزرينعلىضغطتإذاينطفئثم،الأزرارمنواحدعلىضغطتإذاالصمامإضاءةستلاحظ

نصائحبمراجعةقمأوشريحتكعلىوتحميلهالكودمنوتحققصحيحبشكلالدائرةبتجميعقيامكمنفتأكد،يعمللاكان

.أدناهالمساعدة

ستلاحظ؟ماذا 
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مساعدة

لايضيء؟الصمام

بطريقةوضعهالسهلفمن،مربعالزرأنبما

كانإذاماوجربدرجة90ببليهقم.خاطئة

.يعمل

؟لايعملمازال 

ها لذا حاول إخراجها ولف. تعمل المصابيح في اتجاه واحد فقط 

 يلحق لا تقلق ، تثبيتها بالطريقة المعاكسة لا)درجة 180بزاوية 

(.الضرر بها



تطبيقها في الحياة اليومية

.الأزرار في معظم أجهزة التحكم لألعاب الفيديو

50



أسلاك التوصيلمن 7 أخضر صمام مضيء مقياس الجهد

51

Ω مقاومة بجهد

تعتيم الصمام باستخدام مقياس الجهد 3
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مقياس الجهد
(متغيرةمقاومة)

.داخلي1وخارجيان2مآخذ3علىالجهدمقياسيحتوي

،خارجيةالالمآخذعبرفولتاتبتيارخمسةمتصلاً يكونعندما

اعتمادًا،فولط5وفولط0بينجهدًاالأوسطالدبوسيخرج

.الجهدمقياسعلىالمقبضموضععلى

.المتغيرللجهددائرةعلىعبارةهوالجهدمقياس

جهدالمقياساستخدامكيفيةتتعلمسوف،المثالهذهفي

.الصمامإضاءةعلىللسيطرة

A0التماثليةالمآخذأنلاحظ
بوحدةللاتصالمحجوزةA1و

عدميرجىلذافايالواي

وحةاللتعملفلنوإلا،استخدامها

!صحيحبشكل



تماثليأو رقمي 
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إلى

مستوياتك."إيقاف"أو"تشغيل"مجردليستالتيالأشياءمنالكثيرأيضًاهناكولكن

.إلخ،الضوءشدة،الحرارةدرجة

وفرت،لهذهبالنسبة."منخفض"و"عالي"بينالقيممنمستمرةمجموعةلهاجميعها

إلى(فولت0)0منتتراوحقيمةإلىالداخلالجهدتترجمتماثليةمدخلاتستةاللوحة

."يقيالحقالعالم"قيمجميعلقياسمثاليةالتماثليةالمآخذوتعتبر.(فولت5)1023

فقطحالتينعلى،الضغطوأزرارالمضيئةالصماماتمثل،الأجهزةمنالعديدتحتوي

HIGH"(5"بتعرفكما"مشغلغير"أو"مشغل":محتملتين volts)وأ

"LOW"(0 volts).

لمالعاوإلىمنالإشاراتاستقبالأوإرسالفيمفيدةللوحةالرقميةالمآخذتعتبر

وإيقافلتشغيخلالمن)التعتيممحاكاةمثلالحيلببعضالقيامحتىويمكنهاالخارجي،

طريقعنآخرجهازإلىالبياناتنقل)التسلسليةالاتصالاتفيوكذا،(بسرعةالصمام

.(LOWوHIGHبالقيمترميزها

أو
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إخراج هل يمكن للوحة 

جهد تناظري

لأنهانظرًاولكن.حقيقيتناظريجهدخراجإIoTلوحةتستطيعلا

)PWMيسمىماباستخداممزيفجهدإخراجيمكنها،للغايةسريعة

."(النبضعرضتعديل"

أوPWMمعمتوافقةاللوحةعلىالموجودة"~"العلامةذاتمآخذال

يجعلأننيمكبحيثللغايةسريعالمصغرالمتحكم.التناظريةالمخارج

.ثانية/مرة1000منيقربماوويتوقفيوميضمأخذا

كانإذا."منخفض"الجهدفييمضيهالذيالوقتمقابل"عالي"الجهدفيالمأخذيقضيهالذيالوقتمقدارتغييرطريقعنالأمامإلىخطوةPWMيمضي

ونظرًا.باهتابدويسوفالصمامفإن"منخفض"فيوقتهمعظميقضيكانإذا.مشرقاًالمأخذبهذاالمتصلالضوئيالصمامفسيظهر،"عالي"وقتهمعظميقضي

."الحقيقي"التماثليالوهمتخلقاللوحةفإن،عينيكتكتشفهأنيمكنممابكثيرأكبربسرعةيومضالدمأخذلأن
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افتح المسودة

AFF IoT Board folder > Circuits > Dimming_LED_using_Potentiometer



..تعليمات برمجية يجب تدوينها

57

analogValue = analogRead( Pin)مأخذفيالقيمةلقراءةوظيفةاستخداميتم

0)0بين"قيمةوترُجع،"Pin"هناهووواحدا،معاملاتأخذ.تمثيليإدخال

.(فولط5)1023و(فولط

int analogValue:النوعمنمتغيركعننعلنهنانحناستخدامها؛قبلبالمتغيراتالتعريفيجب"

الأحرفلحالةحساسةالمتغيرةالأسماءأنتنسلا.(صحيحعدد)

analogWrite(GreenLEDPin, analogValue):الوظيفةتستعملanalogWriteفيإشارةلتوليد

.(الدورةفي(فولط5)العاليالتيارنسبةوهي)analogValueلالعملدورةمعالأخضرالصماممأخذ



..تعليمات برمجية يجب تدوينها

58

analogValue= map(analogValue, 0, 1023, 0, 255)

ولكن قيادة مأخذ . 1023إلى 0ترجع عددا من , ()analogReadقراءة إشارة تماثلية باستعمال 

على النطاق الأكبر في " الضغط"لذلك يجب . 255إلى 0تتطلب رقما من ()analogWriteباستعمال 

.()mapالنطاق الأصغر باستخدام الوظيفة 

map(value, fromLow, fromHigh, toLow, toHigh)

Value:العدد الذي يتم تحويله

fromLow: الحد الأدنى لقيمة النطاق الحالي

fromHigh : الحد الأعلى لقيمة النطاق الحالي

toLow :النطاق المستهدف الحد الأدنى لقيمة

toHigh :الحد الأعلى لقيمة النطاق المستهدف



بتجميعقيامكمندفتأك،تعملتكنلمإذا.اخترتهالذيالجهدلمقياسوفقاًتعتيماأوإضاءةأكثريصبحالصمامأنستلاحظ

.أدناهالتعليماتبمراجعةأوقم،بكالخاصةاللوحةعلىوتحميلهالكودمنوالتحققصحيحبشكلالدائرة

ستلاحظماذا 
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يعمللا

صرالعن،المساحاتبتوصيلتقملمأنكمنتأكد

بدلاً 2الرقميبالمأخذ،الجهدمقياسفيالمقاوم

مآخذأسفلالمآخذصف)A2التماثليالمأخذمن

..(الطاقة

مساعدة

متقطعبشكلتعمل

معالاتصالرداءةهوالسببأنالأرجح

علىالضغطحاول.الجهدمقياسمأخذ

.الجهدمقياس

؟يضيءلاالصمام

راجهاإخحاوللذا.فقطواحداتجاهفيالمصابيحتعمل

يقةبالطرتثبيتها،تقلقلا)درجة180بزاويةولفها

.(بهاالضرريلحقلاالمعاكسة



تطبيقها في الحياة اليومية

.مقياس الجهدتوظف معظم مقابض الصوت التقليدية  60
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استعمال الشاشة التسلسلية

امنظفيالأمورأهممنواحدةالتسلسليةالشاشةتعتبر

.الأردوينو



الاتصال التسلسلي
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هذاعلى.مللاستلاوالآخرالبياناتلإرسالأحدهما-سلكينمنالتسلسليالناقليتكون

والآخرRXللاستقبالواحد:متسلسلةمآخذالتسلسليةللأجهزةيكونأنيجب،النحو

.TXللإرسال

تلواحدةوالبياناتإرساليتم،التسلسليةالاتصالاتفي

.النهايةحتى،الأخرى

إلىالمرسلمنالبياناتإرساليتم

منالتنسكراتسحبمثلالمتلقي

.الحاويةأنبوب
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افتح المسودة

AFF IoT Board folder > Circuits > Using_Serial_Monitor



التسلسليةالشاشة 

داخلالمكبريشبهذيالالزرفوقانقرثمالبرنامجبتحميلأولاً قم،لفتحها.الأردوينولنظامالتسلسليةالشاشةالمثالهذايستخدم

مثل(الثانيةيفبالبثالسرعة)الباودمعدلنفسعلىضبطهايجب،صحيحبشكلالتسلسليةالشاشةتعملأنأجلمن.مربع

.9600إلىتغييرهفيرجى،9600هوبالباودالبثمعدلإعداديكنلمإذا.باود9600بمعدلالرمزيعمل.التشغيلقيدالشفرة

1

2

64
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Serial.println(“Hello World”):

إلىتنتقلثم،الأنواعجميعمنالمتغيراتذلكفيبما،بداخلهامكتوبشيءأيبطباعةالوظيفةتقوم

.التاليالسطر

.السطرنفسعلىشيءكلتطبعكما

:زيارةيرجى،المعلوماتمنلمزيد

Serial.beginبـالاتصالعليكيجب،التسلسليةالشاشةاستخدامقبل البثمعدل"هو9600.لتهيئتها()

.السرعةبنفسكليهماضبطيجب،البعضببعضهماجهازانيتصلعندما.الاتصالاتسرعةأو،"بالباود

..تعليمات برمجية يجب تدوينها

65



ستلاحظ ؟ماذا 

66

مساعدة

.ثانيةكلرأسعلىالتسلسليةالشاشةعلىعبارةظهورستلاحظ

يتم عرض رطانة

لبيانات يحدث هذا لأن الشاشة التسلسلية تتلقى ا

على

ع انقر على المرب. سرعة مختلفة عن المتوقع

وقم بتغييره "*** baud"الذي يقرأ المنسدل

"baud9600"إلى

لا شيء معروض

حاول الخروج من الشاشة التسلسلية ثم أعد

.تشغيلها مرة أخرى

لا يحدث أي شيء عند فتح الشاشة 

التسلسلية 
ي شريط حاول العثور على نافذة الشاشة التسلسلية ف

ة مهام النوافذ عن طريق تمرير الماوس فوق أيقون

Arduinoثم النقر على الشاشة التسلسلية.



أحمر صمام مضيء Ωمقاومة ذات الجهد  أسلاك التوصيل من

67

"(الإنترنت"عبر )التحكم في الصمام  5



68

ولكنهصغيرضوئيمصدرهوالمضيءالصمام

أولاً .لفةالمختالتطبيقاتمنالعديدفييستخدمقوي

ة،بسيطوظيفةأنهارغم,يومضجعلهعلىسنعمل

.المعقدةالوظائفمنلمزيدالأساسأنهاإلا

الصماميقافإأوتشغيل 
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تحكم في الصمام من 

غيل خلال النقر على  التش

والإيقاف

ل ، قم بالنزول للأسف

ADDوانقر 

LABEL NAME :هو الاسم الذي يظهر في التطبيق.

PARAMETER NAME  :هو الاسم المستخدم في الكودات البرمجية.

أكتب في الفراغ المعلومات

التالية

اختر أيقونة الصمام المضيء



قبل البدء

72

(فايالوايإلزامية للتواصل مع وحدة )تعليمات لإضافة مكتبة جديدة 

1
3

4

، (Tools)وانقر فوق أدوات الأردوينوافتح برنامج 1)

(.ManageLibraries)إدارة المكتبات

«NeoSWSerial».البحث عن 2)
(Install).ثم انقر فوق تثبيت3)
.(close)بمجرد انتهاء التنزيل ، انقر فوق إغلاق4)

2



73

افتح المسودة

AFF IoT Board folder > Circuits > Controlling_an_LED

ستجد هنا الكودات 

رالبرمجية لكل الدوائ



..تعليمات برمجية يجب تدوينها

74

#include <NeoSWSerial.h>:التسلسليةالبرامجمكتبةاستيرادمنالبرمجيةالكوداتمنالسطرهذايمكن،

آخروجهازاللوحةبينالتسلسليللاتصال()الاستقبالمأخذوالإرسالمأخذبمثابةالمآخذمنأيجعلمنالمكتبةهذهوتمكن

.(لوحةفيفايالوايوحدة)

SoftwareSerial WiFiModule(Rx, Tx):النوعمنمتغيرعنالإعلانيتمهنا«»

.فاييالواوحدةمعالتسلسليةللاتصالاتوالاستقبالالإرسالمأخذيليكوناوالمآخذيعين"المسمى



..تعليمات برمجية يجب تدوينها

75

WiFiModule.available():عددوترُجعالإنترنتمنأمرًاتلقتقدفايالوايوحدةكانتإذاماالوظيفةهذهتختبر

.المستلمةالبايتات

.0هيالوظيفةلهذهالإرجاعقيمةتكون،بياناتوجودعدمحالةفي:ملاحظة

String command = WiFimodule.readStringUntil(‘\n’):سلسلةنوعمنمتغيراهنانعرف

.الوايفايوحدةمناستلامهتمالذيالأمرنصبواسطةتعيينهوسيتم,commandباسمالرموز

بلوحةلمفتاحتمثيلوهو)"\"الحرفتلقييتمحتىالبياناتتلقيفيتستمراللوحةأنيعني

.(المفاتيح

.ايالوايفوحدةبواسطةإرسالهتمالذيالأمرعلىللحصولمكتوبهوكماالبرمجيةالكوداتمنالسطرهذادائمًااستخدم:ملاحظة

if(command.indexOf(“red_led”) >= كانتإذاماباختبارالوظيفةتقوم:(0

إذا.الخروجتميحيثالمؤشروترجع(المثالفيالأوامرسلسلة)المتصلسلسلةفيموجودة(كمعامل)قوسينبينالسلسلة

.-1ترُجعالوظيفةفإن،المتصلسلسلةفيموجودةالسلسلةتكنلم



ستلاحظ ؟ماذا 

76

قيامكمنتأكدف،كذلكتكنلمإذا.القيادةلوحةفيالتبديلزرعلىعلىالضغطعندينطفئويضيءصمامالأنستلاحظ

.أدناهالمساعدةنصائحعلىالاطلاعأولوحتكعلىوتحميلهالكودمنوالتحققصحيحبشكلالدائرةبتجميع

يحمل؟لاالبرنامج

هوالسببيكونماوغالبا,أحياناهذايحدث

فيذلكتغييريمكن,الخاطئالمأخذاختيار
tools -> serial port

مساعدة

يضيء؟لاالصمام

اولحلذا.فقطواحداتجاهفيالمصابيحتعمل

،تقلقلا)درجة180بزاويةولفهاإخراجها

.(بهاررالضيلحقلاالمعاكسةبالطريقةتثبيتها



تطبيقها في الحياة اليومية

مؤشر التشغيل و الإيقاف في معظم الأجهزة الإلكترونية 
77



من أسلاك التوصيل5 Ωذات جهد مقاومة خلية ضوئية

78

"(الإنترنت"عبر )قراءة شدة الضوء 6



79

خلية ضوئية

معهاقيمتتختلفمقاومةعنعبارةهيالضوئيةالخلية

كوني،ساطعاًالضوءيكونعندما.الضوءشدةتغير

هدجيكون،الظلاميكونوعندما،عالياًالخروججهد

.منخفضًاالخروج



80



81



82

ي تقوم بمراقبة شدة الضوء ف

الغرفة

ثم بالنزول للأسفل ،قم

ADDانقر 

LABEL NAME :هو الاسم الذي يظهر في التطبيق.

PARAMETER NAME  :هو الاسم المستخدم في الكودات البرمجية.

أكتب في الفراغ المعلومات

التالية



83

افتح المسودة

AFF IoT Board folder > Circuits > Reading_Light_Intensity



84

من قيامك بتجميع إذا لم تكن تعمل ، فتأكد. الضوء على الخلية الضوئيةلشدة ستلاحظ زيادة أو نقصان قيمة المقياس وفقاً 

.اهالدائرة بشكل صحيح والتحقق من الكود وتحميله على اللوحة الخاصة بك أو الاطلاع على نصائح المساعدة أدن

مساعدة

يعمللامازال

.ةللغايمظلمةأومشرقةإماغرفةفيتكونقد

عرفةلمتشغيلهاإيقافأوالأنوارتشغيلحاول

مصباحلديككانإذاأو.يساعدهذاكانإذاما

.بهالاستعانةفيمكنكيدوي

الضوءلتغيراتالخليةتستجيبلا

وئيةالكهروضالخليةعلىالأسلاكتباعدأنبما

علىمحلهاتحلأنالسهلفمن،قياسيغير

.بالمناسالمكانفيأنهمنتأكد.التجاربلوح

ستلاحظ ؟ماذا 



تطبيقها في الحياة اليومية

يستخدم مصباح الشارع مستشعر الضوء للكشف عن وقت تشغيله

85



مقاومة حرارية Ωمقاومة ذات جهد  من أسلاك التوصيل 5

86

"(الإنترنت"عبر )مراقبة درجة الحرارة  7



87

المقاومة الحرارية

علىمقاومتهتعتمدالذيالمقاومةمننوعهيالحراريةالمقاومة

.الإعتياديةالمقاوماتمنحساسيةأكثروهي،الحرارةدرجة

جةلدركمستشعراتواسعنطاقعلىالحراريةالمقاومةتستخدم

التسخينعناصر،(NTCالسالبةالحرارةدرجةمعامل)الحرارة

المقاومةمع.(PTCالموجبةالحرارةدرجةمعامل)التنظيمذاتية

.الحرارةدرجةزادتكلماالمقاومةتنخفض،NTCالحرارية



88



89



90

في تقوم بمراقبة شدة الضوء

الغرفة

ل ، بالنزول للأسفقم

ADDثم انقر 

LABEL NAME :هو الاسم الذي يظهر في التطبيق.

PARAMETER NAME  :هو الاسم المستخدم في الكودات البرمجية.

أكتب في الفراغ المعلومات

التالية



91

افتح المسودة

AFF IoT Board > Circuits > Monitoring_Temperature



ستلاحظ ؟ماذا 

92

مساعدة

قيمة درجة الحرارة لا تتغير

ضغط حاول فرك المستشعر بأصابعك لتسخينه أو ال

.عليه بكيس من الثلج لتبريده

نظامفيليةالتسلسالشاشةعلى،لديكالحرارةدرجةمستشعريكتشفهاالتيالحرارةدرجةقراءةعلىقادرًاتكونأنيجب

اللوحةعلىتحميلهوالكودمنوالتحققصحيحبشكلالدائرةبتجميعقيامكمنفتأكد،تعملتكنلمإذا.تطبيقكوعلىالأردوين

.المساعدةنصائحعلىالاطلاعأوبكالخاصة

يتم عرض رطانة

لبيانات يحدث هذا لأن الشاشة التسلسلية تتلقى ا

انقر على. على سرعة مختلفة عن المتوقع

وقم "*** baud"المربع المنسدل الذي يقرأ 

"baud9600"بتغييره إلى



تطبيقها في الحياة اليومية

أنظمة التحكم في المناخ تستخدم جهاز استشعار درجة الحرارة
.لمراقبة والحفاظ على إعدادات التبريد أو التدفئة

93



Ω مقاومة أسلاك التوصيل

“Humidity and Temperature sensor”

94

"(الإنترنت"عبر )قياس الحرارة والرطوبة 8



95

مستشعر الحرارة و الرطوبة

DHT11الرطوبةوالحرارةمستشعر

ارة يتميز بمجموعة استشعار لدرجة الحرارة والرطوبة مع إخراج إش

.رقمية معايرة

.لحرارةيشمل المستشعر مكونا لقياس الرطوبة ومكونا لقياس درجة ا

يبقى : ملاحظة

3المأخذ رقم 

.  غير متصل



96



97



98

، بالنزول للأسفلقم

ADDثم انقر 

LABEL NAME :هو الاسم الذي يظهر في التطبيق.

PARAMETER NAME  :هو الاسم المستخدم في الكودات البرمجية.

أكتب في الفراغ المعلومات

التالية



99

ل ، بالنزول للأسفقم

ADDثم انقر 

LABEL NAME :هو الاسم الذي يظهر في التطبيق.

PARAMETER NAME  :هو الاسم المستخدم في الكودات البرمجية.

أكتب في الفراغ المعلومات

التالية



100

افتح المسودة

AFF IoT Board > Circuits > Measuring_Humidity_and_Temperature



101

قبل معالجة البيانات
DHTقم بتنزيل مكتبة 

Sketch > Include Library > Manage 

Libraries 



102

قبل معالجة البيانات
DHTقم بتنزيل مكتبة 

»ابحث عن  dht وحدد الإصدار الأحدث من مكتبة «

« SimpleDHT ".تثبيت"وانقر فوق «



103

قبل معالجة البيانات

نظامأننرىأنيمكننا،"إغلاق"الزرفوقالنقربعد

لونهويغيرSimpleDHTنوععلىيتعرفالاردوينو

.البرتقالياللونإلى

DHTقم بتنزيل مكتبة 



104

ةالقراءوظيفةالبرمجيةالكوداتمنالسطرهذايستدعي

رالاستشعاجهازمنالحرارةودرجةالرطوبةعلىللحصول

و"الحرارةدرجة"متغيراتفيالقيمويضع,

."الرطوبة"

dht.read(&temperature, &humidity, NULL):

..تعليمات برمجية يجب تدوينها



ستلاحظ ؟ماذا 

105

بشكلالدائرةبتجميعقيامكمنفتأكدذلك،يتملمإذا.الحرارةدرجةوللرطوبةالحقيقيةالقيمرلكظهت

.أدناهالمساعدةنصائحعلىالاطلاعأوبكالخاصةاللوحةعلىوتحميلهالكودمنوالتحققصحيح

مساعدة

لا شيء يحدث

.  ملهذا البرنامج لا يوجد لديه إشارة إلى الخارج أنه يع

ظام للاطلاع على النتائج ، يجب عليك فتح شاشة ن

.الأردوينو التسلسلية

القيم لا تتغير

ضغط حاول فرك المستشعر بأصابعك لتسخينه أو ال

.على كيس من الثلج بالقرب منه لتبريده



تطبيقها في الحياة اليومية

ةقياس الرطوبة في غرف التخزين لمنع تلف العناصر المخزن

106



صمام مضيء Ωذات الجهد مقاومةمن ال3 من أسلاك التوصيل5

107

"(الإنترنت"عبر ) RGBضبط لون الصمام  9



108

صمام المضيء ال

، على ( الأحمر والأخضر والأزرق) RGBتحتوي مصابيح 

ا لإنشاء ثلاث ثنائيات مختلفة ينبعث منها اللون ويمكن دمجه

مام صفي هذه المثال ، ستتعلم كيفية استخدام . كل الألوان

RGBللحصول على ألوان فريدة من نوعها.

أي تركيب اعتمادًا على مدى سطوع كل صمام ثنائي ، يكون

!لون تقريباً ممكناً



109



110



111

اختر لونا ثم اضغط زر 
choose

ثم بالنزول للأسفل ،قم

ADDانقر 

LABEL NAME :هو الاسم الذي يظهر في التطبيق.

PARAMETER NAME  :هو الاسم المستخدم في الكودات البرمجية.

أكتب في الفراغ المعلومات

التالية



112

افتح المسودة

AFF IoT Board folder > Circuits > Adjusting_RGB_led_Color

1



113

افتح المسودة

AFF IoT Board folder > Circuits > Adjusting_RGB_led_Color

2



114

RedValue = RedStringValue.toInt():تبدأأنيجب.صحيحعددإلىصالحةسلسلةتحويل

.التحويلراءإجعنالوظيفةفستتوقف،صحيحعددغيرأرقامعلىتحتويالسلسلةكانتإذا.صحيحبرقمالإدخالسلسلة

Command.substring(index):إلىمؤشرمعينمنمعينةفرعيةسلسلةعنيبحث،فقطواحدبمعامل

.(المثالهذافي)السلسلةنهاية

..تعليمات برمجية يجب تدوينها



ستلاحظ ؟ماذا 

115

مساعدة

خاطئةألوانايظهرأولايضيءالصمام

،ضالبعبعضهامنجدًاقريبةالصماممنمساميرأربعةوجودمع

تميحيثالمآخذمنتحقق.أحدهااستبدالأحياناًالسهلمنيكون

.منهاكلإدراج

الدائرةعبتجميقيامكمنفتأكد،ذلكيتملمإذا,ومرحةجديدةبألوانالمرةهذهلكن,يضئالصمامأنستلاحظ

.أدناهالمساعدةنصائحعلىالاطلاعأولوحتكعلىوتحميلهالكودمنوالتحققصحيحبشكل

أحمرالضوء

منقليلاً إشراقاًأكثرRGBالصمامداخلالأحمرالثنائيالصماميكونقد

ً أكثرألوانكلجعل.الأخريينالاثنين أومذاتمقاومةاستخدم،توازنا

:كالآتيالبرمجيةالكوداتفياضبطهأو.الأحمرللونأعلى
analogWrite(RedledPin, RedValue);

To analogWrite(RedledPin, RedValue/3);



تطبيقها في الحياة اليومية

لإظهار ألوان مختلفة داخل نفس RGBتستخدم العديد من الأجهزة الإلكترونية مثل وحدات التحكم في ألعاب الفيديو الصمام المضيء 

.مصدر الضوء
116



صمام مضيء Ωمقاومة ذات جهد  من أسلاك التوصيل" 

117

جدولة المراقبة 10



118

مصماتشغيل وإطفاء ال

ولكنهصغيرضوئيمصدرهوالمضيءالصمام

أولاً .لفةالمختالتطبيقاتمنالعديدفييستخدمقوي

ة،بسيطوظيفةأنهارغم,يومضجعلهعلىسنعمل

.المعقدةالوظائفمنلمزيدالأساسأنهاإلا



119



120



121

غط تحكم في الصمام بالض

OFFو  ONعلى

، ثم بالنزول للأسفلقم

ADDانقر 

:  الخطوة القادمة 

وضع جدول 

زمني

LABEL NAME :هو الاسم الذي يظهر في التطبيق.

PARAMETER NAME  :هو الاسم المستخدم في الكودات البرمجية.

أكتب في الفراغ المعلومات

التالية

أختر أيقونة الصمام المضيئ



122

يمكنك تعديل أو حذف أو تعطيل

الجدول



123

تفسير

(.فعال أم لا)يحدد حالة الجدول : فعال -

.هو عنوان الجدول الذي تم إنشاؤه: العنوان-

(.OFFأو  ONصمام مضيءاختر)هي عنصر التحكم الذي ستتم جدولته : الميزة -

.هو الوقت الذي سيتم فيه تنفيذ الإجراء: الوقت-

.هو التاريخ الذي سيتم فيه تفعيل الجدول: تاريخ البدء-

إذا تم تحديد خانة الاختيار تكرار ، فأنت بذلك: الأيام المتكررة-

.يمكن أن تختار ما هي الأيام التي يتم فيها التفعيل

.حفظ الجدول الزمني أو إلغائه-



124

المؤقت

كم فيه  يمكن خيار المؤقت من اختيار العنصرالمتح

تنفيذ بعد هذا التأخير سيتم. وتحديد وقت تأخير

.الأمر

ر فوق يمكنك أيضًا إيقاف المؤقت عن طريق النق

.، وسيتم تجاهل الإجراء المتأخر" إيقاف"الزر 



125

افتح المسودة

AFF IoT Board folder > Circuits > Examples > Scheduling_Controls

الصماممراقبة5المثالفيكماالمثالهذاسيعمل

.الصماماسمفيتغييرمعالمضيء



ستلاحظ ؟ماذا 

126

الصمام إذا اخترت زر الإيقاف ستلاحظ انطفاء. ستلاحظ أن  الصمام يضيء بعد عشر ثواني

.بعد مرور الوقت المحدد

مساعدة

يضيء؟لاالصمام

اولحلذا.فقطواحداتجاهفيالمصابيحتعمل

،تقلقلا)درجة180بزاويةولفهاإخراجها

.(بهاررالضيلحقلاالمعاكسةبالطريقةتثبيتها



تطبيقها في الحياة اليومية

معظم أجهزة أنترنيت الأشياء تضم مؤقتا

127



خلية ضوئية أصفرصمام مضيء Ωمقاومة ذات الجهد 

128

Ω مقاومة ذات الجهد

أسلاك التوصيلمن 5

محاكاة نظام الإضاءة الآلي 11



129

محاكاة النظام الحقيقي

.المحاكاة هي تقليد لعملية حقيقية

تم لذلك في العالم الحقيقي ، بدلا من الصمام ، ي

.استخدام المصباح الكهربائي

بدلاً من المصباح الصمام المضيءlيتم استخدام 

يد من لأسباب تتعلق بالسلامة أثناء تطبيق العد

.التجارب



130



131



132

، بالنزول للأسفلقم

ADDثم انقر 

LABEL NAME :هو الاسم الذي يظهر في التطبيق.

PARAMETER NAME  :هو الاسم المستخدم في الكودات البرمجية.

أكتب في الفراغ المعلومات

التالية



133



134

، بالنزول للأسفلقم

ADDثم انقر 

LABEL NAME :هو الاسم الذي يظهر في التطبيق.

PARAMETER NAME  :هو الاسم المستخدم في الكودات البرمجية.

أكتب في الفراغ المعلومات

التالية



135

RULEADD NEWأضغط 

 ADDأضغط
CONDITION

أضغط NEXT

أختر اللوحة



136

أختر Light 
Intensity

أضغط
EDIT 

ACTIONS

1

2

3



137

FINISHأضغط 

قم بتشغيل المصباح

ها يمكنك تحرير القاعدة أو حذف

أو إلغاء تنشيطها

الآن عندما تكون شدة 

٪ ، يتم 50الإضاءة أقل من 

تشغيل الصمام الأصفر 

(ةمصباح في الحياة الحقيقي)

للعودة BACKانقر فوق 
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وأخيرا

٪ 50ة كرر العملية ولكن بدلاً من ذلك حدد شدة الإضاءة لتكون أقل بنسب

.هو إيقاف التشغيلهدف وال

.يمكنك ضبط نسبة شدة الإضاءة لتتناسب مع إضاءة غرفتك
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افتح المسودة

AFF IoT Board folder > Circuits > Examples > Automated_Lighting_System



ستلاحظ ؟ماذا 
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زدادتعندماينطفئو,الغرفةإضاءةتنخفضعندمايضيءالأصفرالصمامأنستلاحظ

.إضاءتها

مساعدة

والصمامفيالتحكممثاليإلىالعودةبإمكانك

.الضوءشدةقراءة



تطبيقها في الحياة اليومية

ة المحددة مسبقاً ، يتم تشغيلها عندما يكون المصباح أقل من العتب. في الآونة الأخيرة ، تأتي معظم المصابيح مع مستشعر إضاءة مدمج
.ويتم إيقاف التشغيل بطريقة أخرى
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جرس مقاومة حرارية أسلاك التوصيلمن 7
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Ωمقاومة ذات جهد 

إنذار ارتفاع درجة الحرارة 12
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الجرس

ق الجهد سنستخدم جرسا يصدر صوتاً عند تطبي

!عليه

.هذا المثال هو مقدمة لأنظمة الإنذار
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، ثم بالنزول للأسفلقم

ADDانقر 

LABEL NAME :هو الاسم الذي يظهر في التطبيق.

PARAMETER NAME  :هو الاسم المستخدم في الكودات البرمجية.

أكتب في الفراغ المعلومات

التالية
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، ثم بالنزول للأسفلقم

ADDانقر 

LABEL NAME :هو الاسم الذي يظهر في التطبيق.

PARAMETER NAME  :هو الاسم المستخدم في الكودات البرمجية.

أكتب في الفراغ المعلومات

التالية
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RULEADD NEWأضغط 

 ADDأضغط
CONDITION

أضغط NEXT

أختر اللوحة
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أختر
Temperature

أضغط
EDIT 

ACTIONS

1

2

3
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يمكنك تحرير القاعدة أو

احذفها أو إلغاء تنشيطه
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افتح المسودة

Open AFF IoT Board// Circuits > Examples >Overheat_Alarm

في هذا المثال، افترضنا أن مستشعر درجة الحرارة هو 

حرارة عندما ترتفع درجة ال. تركيب صمام مضيء في الغرفة

درجة مئوية ، يجب على الجرس إصدار C °35لتصل إلى 

.صوت إنذار

حكم هذه الكودات البرمجية هي مزيج من الكودات البرمجية للت

.في الجرس و مراقبة درجة الحرارة 



ستلاحظ ؟ماذا 
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بتجميعقيامكمنفتأكد،يعمللمإذا.المستشعرباتجاهالضوءتقريبعندصوتاًتسمعأنيجبولكن!شيءلا

.أدناهالمساعدةنصائحراجعأولوحتكعلىوتحميلهالكودمنوتحققصحيحبشكلالدائرة

مساعدة

أيضاصوتلا

احرصلذامستقطب،بأنهالجرسهذايتميز

"+"العلامةيحملالذيالمأخذتوصيلعلى

.بالأرضيوالآخرالرقميبالمأخذ

صوتأييسمعلا

تتفويالسهلفمنالجرس،وشكللحجمنظرًا

منجيداتحقق.اللوحعلىاليمنىالثقوب

.موضعها



تطبيقها في الحياة اليومية

.عند إطلاق إنذار( أو صفارات الإنذار)تستخدم جميع أنظمة الأمان أجراسا 
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هتنوي

AFF Asset Switzerlandبواسطة2019© حقوق النشر  S.A. ,جميع الحقوق محفوظة  .

.ومواصفاتها ، ومتطلبات النظام ، ومدى توفرها للتغيير دون إشعارAFF IoTولوحة , AFF IoTتخضع مجموعة أدوات 

.جميع العلامات التجارية الأخرى الواردة هنا هي ملك لأصحابها
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